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wysiwyg Release 39  
 
Thank you for installing wysiwyg Release 39. These release notes provide information 
about documentation and known issues related specifically to wysiwyg Release 39. 

 

 

wysiwyg Release 39 ............................................................................................. 1 

Getting started with wysiwyg R39 ............................................................................ 3 

Documentation sources ..................................................................................... 3 

Sample files ................................................................................................ 3 

Template files ............................................................................................. 3 

CAST Forum ................................................................................................ 3 

Useful information .............................................................................................. 3 

wysiwyg compatibility with Vivien-Virtual Event Designer ........................................... 3 

Vivien file version compatibility ........................................................................... 4 

Operating system compatibility ........................................................................... 4 

Hard drive compatibility .................................................................................... 5 

Video card compatibility .................................................................................... 5 

Membership requirements for Release 39 ............................................................... 6 

Customer Experience Improvement Program (CEIP) ...................................................... 6 

New features and enhancements in wysiwyg R39 ......................................................... 7 

General Application Updates .................................................................................. 7 

Dongle Security Update ..................................................................................... 7 

CAD Mode Features .............................................................................................. 8 

Library Item - Specify Insertion Point .................................................................... 8 

Library Snaps .................................................................................................. 9 

Self-Snapping while Drawing a CAD Object ............................................................ 10 

Grid Array has been Added to the Toolbar ............................................................ 11 

Array Tool Enhancement - Use Object Extents ....................................................... 12 

Mirroring Text Labels ...................................................................................... 13 

Enhancements to Text Labels - Insert Smart Variable and Item Data Buttons .................. 13 

Motion Axis and Frames Object Enhancements ....................................................... 17 

Printing with your Floorplan image ..................................................................... 17 

Mode Attribute Added to Fixture Attribute Layouts (FALs) ......................................... 18 

Figure 14 - Screenshot of the FALs Editor dialog, highlighting the Mode attribute. ........... 18 

New Fixture Beam Sliders in Beam Options............................................................ 19 



  

 

 

  Page 2 of 62   

© CAST Group of Companies Inc., 2017. All rights reserved. 

Invert Selection for Objects and Fixtures .............................................................. 19 

Custom Library Objects Loaded On-Demand to Preserve Memory ................................. 20 

Visualization Features ........................................................................................ 21 

Alpha Beam Shadows ...................................................................................... 21 

Image Manager Displays Alpha Levels in Image Preview ............................................ 22 

Shaded View Export as a Panoramic Image ............................................................ 23 

Fixture Highlight (in DESIGN mode only) ............................................................... 24 

AutoCAD Importing Improvements ......................................................................... 25 

Data Mode Features ........................................................................................... 27 

Mode Column is now Available in Spreadsheets ...................................................... 27 

Presentation (PRES) Features ............................................................................... 28 

Batch Printing Improvements ............................................................................ 28 

Legend Improvements ..................................................................................... 28 

General Features .............................................................................................. 29 

Scene Database Improvements .......................................................................... 29 

CyberMotion Added to Device Manager................................................................. 29 

Library - New Fixtures Additions and Corrections ....................................................... 30 

New Library items in wysiwyg R39 ......................................................................... 30 

New Automated Fixtures .................................................................................. 30 

New LED Conventional Fixtures .......................................................................... 32 

New LED Fixtures ........................................................................................... 32 

New Conventional Fixtures ............................................................................... 35 

New Effects .................................................................................................. 36 

New Video Projector ....................................................................................... 37 

New Accessories ............................................................................................ 37 

New Truss .................................................................................................... 37 

New Gobos ................................................................................................... 41 

New Library Items .......................................................................................... 46 

Updated Library items in wysiwyg R39 .................................................................... 48 

Resolved Issues in wysiwyg R39 ............................................................................. 50 

Known Issues ................................................................................................... 53 

Contacting Technical Support ............................................................................... 62 

Copyright Information ........................................................................................ 62 
 



  

 

 

  Page 3 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

Getting started with wysiwyg R39 

To help you get started using wysiwyg, various resources are available for your use.  

Documentation sources 
Documentation sources are available in several locations for your convenience: 

• On your Windows computer, click Start > Programs > CAST Software > WYSIWYG 
Release 39 shortcut menu (once wysiwyg has been installed) 

• All wysiwyg documentation is available for download from the CAST web site:   
http://www.cast-soft.com/ 

 Sources include: 
• Reference Guide 
• Quick Start Guide 
• Release Notes  

Sample files 
Sample wysiwyg files are provided with the installation for you to use as examples or 
references. There are sample AutoCAD files, report heading files, as well as several files 
from various disciplines. These files can be found in the \Samples folder where you installed 
wysiwyg (e.g., C:\Program Files (x86)\CAST Software\WYSIWYG Release 39\Samples).  

Template files 
Template files are provided with the installation for you to use as desired. There are several 
basic templates such as plot, studio, and theatre files. These files can be found in the 
Templates folder where you installed wysiwyg (for example, C:\Program Files (x86)\CAST 
Software\WYSIWYG Release 39\Samples\Templates). 

CAST Forum 
CAST has launched the CAST Forum, http://forums.cast-soft.com/. The Forum is open to 
everyone and aims to serve both CAST product users as well as the entire entertainment and 
event production community, it is not just about CAST products. Forum members can post 
projects, ask questions, get technical support from the community or just browse to see 
what others are doing. 

Useful information 

wysiwyg compatibility with Vivien-Virtual Event Designer 
Are you a Lighting Designer who manages venue layouts, produces events, or liaises with 
event planners/designers or service providers?   

wysiwyg is compatible with Vivien-Virtual Event Designer, CAST Software’s award-winning 
special events planning and design software tool. You can create your shows in wysiwyg 

http://www.cast-soft.com/
http://forums.cast-soft.com/
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and then open the files in Vivien to make use of its automated Wizards for adding event 
items, such as seating areas, tables, and chairs.  

You can use Vivien Virtual Event Designer to increase your planning efficiency. Vivien is the 
sales, planning, design, and production tool designed for the meeting and special events 
industry. LDs can use it for creating quick concepts to demonstrate their ideas. As wysiwyg 
deals with the stage, Vivien deals with the venue. Both wysiwyg and Vivien:  

• Feature simplified CAD tools to plot or lay out floor spaces or lighting plans 
• Deliver photorealistic renderings of these drawings 
• Contain 1000s of library objects designed for the industry 
• Share the same reliable, robust base code 
• Deliver eye-popping visuals 
• Provide wizards for common tasks 

 

Vivien file version compatibility 
Due the differing release schedules of Vivien and wysiwyg, a Vivien 2017 file will open in 
wysiwyg R39, but a Vivien 2017  installation will not open an R39 file; it can open files 
saved back to R38 format. Note, to open a wysiwyg file and display fixtures and truss in 
Vivien, please download and install the wysiwyg Compatibility Pack before opening the file.  

Operating system compatibility 
wysiwyg is supported on Windows 7, Windows 8.1 and Windows 10. 

wysiwyg Release 39 is supported on Windows 7, Windows 8.1 and Windows 10. wysiwyg 
Release 39 will not install or run on Windows XP or Windows Vista.  
 

Minimum system requirements (for general wysiwyg usage) 
 

• Intel Core i3 or compatible processor, 2.0 GHz, or better 
• PC running Windows 7 with Service Pack 1, Windows 8.1, or Windows 10 
• MAC computer with Intel Processor platforms running Windows 7 with Service Pack 1 

or Windows 8.1 or Windows 10 via Bootcamp (recommended), or Parallels Virtual 
Machine* 

  *wysiwyg installed on a Parallels Virtual Machine will run with limited  
  graphical functionality, as it is running on an Integrated video card. 

• 4GB RAM 
• 1GB free disk space (NTFS file system) 
• 1280 x 800 resolution 
• OpenGL-accelerated “gaming-level” video card, with 1GB (or better) video memory 

and OpenGL 2.1 (minimum) support** 
** Integrated video cards may be used, but are not recommended. 

• Free USB port 
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High performance system requirements  
(for best response and rendering time) 
 

• Intel Core i5 / i7 / i7 “Extreme Edition” or equivalent AMD processor, quad-core or 
better, 2.4 GHz or better 

• Windows 7 with Service Pack 1, Windows 8.1, or Windows 10; 64-bit version of 
Windows OS is not required, but highly recommended 

• MAC computer with Intel Processor platforms running Windows 7 with Service Pack 1, 
Windows 8.1, or Windows 10, running via Bootcamp 

• 8GB RAM or better, configured for dual-, triple- or quad-channel operation 
(depending on the memory architecture supported by the system processor) 

• 1GB free disk space (NTFS file system) 
• OpenGL-accelerated “gaming-level” video card, with 3GB (or better) video memory 

and OpenGL 3.3 support required for Deferred Rendering simulation and Volumetric 
Beams in Shaded Views  

• No integrated video cards should be considered for such a system 
• Free USB port 

 
Hard drive compatibility 
Due to restrictions in file name length, you cannot install wysiwyg on a FAT32-formatted 
hard drive. Instead, you must install the product on an NTFS-formatted hard drive. For 
details, see https://www.cast-soft.com/cast/downloads/download-install.php 

Video card compatibility 
There are two levels of beam simulation offered in wysiwyg's Shaded Views. 

• Enhanced Beams: The minimum video card requirements to display the default 
Enhanced Beams must support OpenGL 2.1. 

• Volumetric Beams: To obtain the highest graphics level offered by Deferred 
Rendering with Enhanced Visualization, your video card must support OpenGL 3.3 or 
better. 

Note: Both Enhanced Visualization and Deferred Rendering options are required to 
run Volumetric Beams. If these options are not available on your system, it means 
the graphics card on your computer does not support the necessary version of 
OpenGL to run Volumetric Beams. In this instance, you must use Enhanced Beams for 
your Shaded View visualization. 
 
Note: For the Alpha Beam Shadows feature requires a video card that supports 
OpenGL 4.3 or better. 

 

https://www.cast-soft.com/cast/downloads/download-install.php
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Membership requirements for Release 39 
 
Your wysiwyg dongle membership must be valid at least until June 2017 (or later) to run 
the wysiwyg Release 39. 

 

Customer Experience Improvement Program (CEIP) 

CAST is always looking for new ways to improve its products in order to provide the best 
software for you, our customers. Around 3 years ago, we introduced the Customer 
Experience Improvement Program (CEIP) into our products; it is a new way to allow our 
customers to contribute to the features, design and development of wysiwyg, and we 
encourage everyone to turn the CEIP feature on. 

 
Please note the following: 
 
1.  The information 
collected is analyzed for 
trends and helps us make 
decisions on how to plan 
our efforts to improve our 
software.  
 
2.  All information 
collected is anonymous. 
 
3.  When enabled, the CEIP 
program runs 
automatically in the 
background, and will not 
interfere with your work in 
any way. 
 
We look forward to your 
help! 
 
Thank you. 
CAST Development Team 

 

Figure 1 - CEIP dialog. 
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New features and enhancements in wysiwyg R39  

Release 39 includes the following new features and enhancements. For details on these new 
features, please see the wysiwyg Reference Guide. 

 

General Application Updates 

Dongle Security Update 

 
A new level of security has been introduced into wysiwyg Release 39. wysiwyg will 
continue to work like it did before using your current dongle, so you should not experience 
any differences in your workflow. If you do, please report them to our Technical Support 
team, techsupport@cast-soft.com. This security update is part of our efforts to keep your 
investment and our investment into wysiwyg protected from non-customers. We appreciate 
all of your support over the years, and often reporting to us when illegal copies have 
surfaced. Thank you in advance for your patience as we continue to make some security 
updates in the never ending battle against software piracy. 
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CAD Mode Features 

Library Item - Specify Insertion Point 
 

This feature allows you to select the insertion point when inserting a Library item into your 
drawing. Once the Library object insertion begins, right-click to access the insertion point 
list (as shown below in the screenshot). By default, all Library items will use their “Default” 
insertion point, as defined by the library model. In addition to the default, there are 10 
available insertion points. If you picture a bounding box around the Library item, you can 
choose from any of the top corners of the bounding box, or bottom corners, or top center, 
or bottom center, as shown in the image below.  

Upon selecting a different insertion point, the cursor will switch to the specified point and 
insertion will continue with this insertion point. The insertion point is identified by a red 
square when Library Snap is enabled (as explained by the next section), and selected 
objects are identified with a green square. Switching the Library item’s insertion point can 
help with using Snaps to insert a Library item in your drawing depending on the situation.  

 

Figure 2 - Screenshot showing the updated Library item insertion point options in the right-click 
menu, and a Staircase Library item is used to label all the insertion points around the object. 

Note: Once a Library Item’s insertion point has been changed during insertion within the 
project, it is remembered for future insertions from the Library Browser, and will be used 
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when performing some CAD operations such as Copy/Paste, and Move and Rotate (when 
object’s base point is preferred in these operations). 

 

Figure 3 - Screenshot showing the new right-click options when inserting a Library Item. In this 
example, while inserting the Stairs item, its insertion point was switched to Bottom Back Right. 

 

Library Snaps 
 

With the enhancements made by the Library Insertion Point feature, a related 
improvement is to be able to snap to any corner of the Library Object’s bounding box. To 
make this possible, we have introduced Library Snaps, which are points drawn at the 
bounding box corners of a library item, and one corner will be displayed in red, to represent 
the library item’s insertion point, which we discussed in the previous section. When the 
Library Snap is not enabled, the library objects which are drawn in the file will look the 
same as always (without points around the item). When Library Snap is enabled, all library 
items that are in the drawing will display their snap points, and can be used as a snappable 
point while you are working in the CAD Wireframe views like any other snap point. These 
are especially useful when inserting modular library objects, such as Stage Platforms or 
Dance Floors. 
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Figure 4 - Screenshot showing three Staircase library items, which were inserted with Library Snap 
on, and Bottom Front Left as the Insertion Point, as identified by the red points in the drawing. 

Note, during CAD operations like Move and Rotate, the Library Snap points will be 
automatically turned on for your convenience, in case you wish to use them to select a base 
point for your move or rotation. 

 

Self-Snapping while Drawing a CAD Object 
 

Many times when drawing a Line or Surface, or when drawing a room using the Room Builder 
feature, it would be convenient if snapping would work on the object that is currently being 
drawn, i.e. that the next point you wish to add could be based off an existing vertex/corner 
of the object that could be snapped to.  

In R39, the scenario described is now possible for Lines, Surfaces, and Room Builder. While 
drawing any of these objects, all the points drawn so far will be available for end-point, 
mid-point, and/or intersection point snaps.  
 
Tip: Using this new feature along with the Ortho tool can be very useful. 
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Figure 5 - Screenshot of a Line object currently being drawn, and the latest vertex of the Line was 
defined by using End Point snap to the first point of the Line (so these points are aligned). 

 

Grid Array has been Added to the Toolbar 
 

   Since the Grid Array is becoming more popular, we have added a Grid Array 
button to the Array mini-toolbar, which is available on the Tools toolbar. 

 

Figure 6 - Screenshot of the Array mini Toolbar. The 3rd button is for Grid Array. 
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Array Tool Enhancement - Use Object Extents 

 
In the Array dialogs, a new button "Use object extents for interval" has been added which 
will automatically populate the Interval textboxes with the dimensions of the selected 
object. 
 

 

Figure 7 - Screenshot of Grid Array dialog showing the new "Use object extents for interval" button. 
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Mirroring Text Labels  

 
When mirroring Text Label objects, the Text Label’s position/rotation, anchor position, 
callouts and arrows will be mirrored across the mirror plane, but the text will now face the 
screen so it is always legible to anyone looking at the drawing. Previously the Mirror 
operation would reverse the text, making it appear backwards. 

 

Figure 8 - Screenshot displaying results of new Mirroring logic on various Text Label object 
examples. 

 

Enhancements to Text Labels - Insert Smart Variable and Item Data Buttons  
 

When adding Text Labels to include notes into your drawing, often it is information about 
the Show or about equipment that is drawn onto the stage or venue. Since this information 
is often already stored in the Document Options or available in wysiwyg’s library, we have 
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added two new buttons to the Text Label dialog to make things easier to get down on 
paper… 

 

Figure 9 - Screenshot of the updated New Text Label dialog, showing new "Insert Smart Variable" 
and "Insert Item Data" buttons. 

 Insert Smart Variable 
Clicking on the Insert Smart Variable button will open the Production Team Info list. 
Since you already entered the information, select the row containing the text you wish 
to add into your text label and it will be inserted into the Text textbox.  
 
Note, at the bottom of the dialog, there is an option to include the Variable Name, in 
case you wish to show both Variable Name, and its Value (information). 



  

 

 

  Page 15 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

  
 

 

Figure 10 - Screenshots of the Smart Variables dialog, and the resulting Text Label object inserted 
into the drawing. 
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 Insert Item Data 
Similarly, you have plenty of Fixtures and Truss in your drawing, and typing in the 
catalog name of the Truss, or any other info for Truss or Fixtures, can be a very tedious 
task.  
 
Now you can initiate the “Retrieve Item Data” command from the LIBRARY > Retrieve 
Item Data menu in CAD, and from the EDIT > Retrieve Item Data menu in PRES > New 
Plots, and then click on a Fixture or Truss item. Then from the Item Data dialog, select 
the Value (information) you wish to include in your note, and it will be inserted into the 
Text Label’s textbox. 
 
For your convenience, at the bottom of the Item Data dialog, there is a Recent Items 
dropdown which will list the last 5 items whose item data was retrieved previously. 
 

 

Figure 11 - Screenshot of the new Item Data dialog displaying Item Properties retrieved for a Truss 
object. 

 

 



  

 

 

  Page 17 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

Motion Axis and Frames Object Enhancements 
 

To simplify things while you are working on adding Axis and Frame objects into your 
drawings, we have made some enhancements to the Axis and Frame object representations 
and their properties. 

 Name Displayed 
The Name of the Axis/Frame will now be displayed in the Drawing, as is the case for 
Focus Objects. 
 

 

Figure 12 - Screenshot of a Linear Axis with its Axis name displayed in the CAD drawing. 

 Text Properties 
To adjust the appearance of the Name, the Text Properties of position, alignment, and 
font have been added in the Motion Object's properties. 
 

 Motion Object Prefix in "Attach to Axis/Frame" dropdown 
To help identify if a Motion Object is a Linear Axis, Rotation Axis or Frame, we've added 
the following Prefixes, respectively, to the listed items: [Ax-L], [Ax-R], and [FRM]. 

 

Printing with your Floorplan image 
 

It is now possible to print an imported Floorplan image or PDF file with your paperwork. If 
the floorplan is visible in the CAD Wireframe view, it will also appear in the CAD object of 
your Layouts and in New Plots of PRES mode. 

Attention: Imported floorplans are a purely visual feature without any guarantee of 
accuracy and precision in the printed document. When printing a floorplan, a Warning 
dialog appears asking for you to acknowledge that there are no guarantees about the 
content, accuracy, precision, or anything else in the printed document and that you will 
not hold CAST responsible for any errors or inaccuracies in the document. Mark the 
checkbox and click OK to proceed. 



  

 

 

  Page 18 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

 

Figure 13 - Screenshot of the Warning dialog that appears when a Floorplan is displayed. 

 

Mode Attribute Added to Fixture Attribute Layouts (FALs) 
 

Mode has been added to the Fixture Attribute Layouts (FALs), so the Mode can be 
displayed as an attribute around a Fixture Symbol on your drawing. 
 

 

Figure 14 - Screenshot of the FALs Editor dialog, highlighting the Mode attribute. 
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New Fixture Beam Sliders in Beam Options  
 

In the Fixture Properties > Beam Options tab, the previous checkboxes for Flare, Beam 
and Footprint have been replaced with Sliders, allowing you to control the brightness of 
these Beam properties. Additionally, a new property for controlling Source Disc is now 
available. 
 

 

Figure 15 - Screenshot of the new Beam Setting Sliders in Fixture Properties > Beam Options. 

 
Invert Selection for Objects and Fixtures 

 

  A new object selection has been introduced in CAD. From EDIT > Select 
Special, or press the INV button from the Selection Toolbar, or press CTRL+I to deselect 
all editable objects currently selected, and consequently select all the other editable 
objects that were previously not selected.  
 

 

Figure 16 - Screenshot of the Selection toolbar, including the new INV button for Invert Selection. 

Additionally, you can use CTRL+SHIFT+I to invert the selection of fixtures, deselecting 
all currently selected fixtures, and selecting the other fixtures which were previously 
not selected. 
 
Note: Invert selection is also available in Design and Live mode. 
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Custom Library Objects Loaded On-Demand to Preserve Memory 
 

To preserve memory usage on loading the application, wysiwyg is now utilizing a load 
on-demand strategy for its custom library objects, instead of always loading all available 
custom library objects. This means that only one instance of wysiwyg has full 
permissions to edit the custom library object database.  
 
When a second instance of wysiwyg is launched, a warning will be displayed to inform 
that the second instance will be running in read-only mode. 

 

 

Figure 17 - Screenshot of the new Warning message when a second instance of wysiwyg is launched. 
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Visualization Features 

Alpha Beam Shadows 

 
In Release 38 we added the Alpha Texturing feature which introduced the ability for beams 
to pass through surfaces where Alpha Transparency was specified in the image.  

As a follow up to this feature, in Release 39, we are taking it one step closer to reality by 
considering the color and Alpha percentage/value in the image and altering the beam’s 
color and intensity as it passes through the surface. 

 

Figure 18 - Screenshot of the new Alpha Beam Shadows feature, displaying the white beam passing 
through a Stained glass window texture. The beam passing through takes the colors of the alpha 
texture, and the beam's intensity drops to half the intensity as a result of the 50% alpha levels. 

To enable Alpha Beam Shadows in your Shaded View, open the Shaded View’s View 
Options, and in the Simulation tab with Volumetric Beam mode set, select the “Enable” 
checkbox in the Alpha Beam Shadows section. Set the “Num. Levels” dropdown to the 
number of levels to be calculated for Alpha Beam shadows. For example, if this dropdown is 
set to 2, a beam’s color and intensity will be calculated based on passing through 2 surfaces 
with alpha levels only; any additional surfaces with alpha levels will be ignored as the beam 
will just pass through them.  
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Note: Each alpha shadow level supported for this feature requires additional video memory 
from your graphics card, and can impact performance, depending on your scene and 
computer’s hardware, so use this feature wisely.  

Reminder: Alpha Texturing is supported with PNG images containing alpha transparency 
built into the image. For more information about using Alpha Textures, please see  
http://forums.cast-soft.com/index.php?threads/using-alpha-in-r38.662/. 

 

Image Manager Displays Alpha Levels in Image Preview 
 

With the new features of Alpha Textures and Alpha Beam Shadows in R38 and R39 
respectively, we have updated the preview in the Image Manager to display a grey checker 
pattern wherever there is alpha levels defined in the image. 

 

Figure 19 - Screenshot of the Image Manager showing a grey checker pattern to identify where 
there are alpha levels in the image. 

 

http://forums.cast-soft.com/index.php?threads/using-alpha-in-r38.662/
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Shaded View Export as a Panoramic Image 
 

The Shaded View Export now has a new Panorama option when exporting the Shaded View 
as an image. When selected, a Panoramic image can be exported as a Spherical image (full 
360 degrees camera including top and bottom), or a Cylindrical image (only sides, up to 360 
degrees).  

The exported Panorama image includes metadata that will be recognized by other 
applications and browsers, so it can be viewed as a 360 panoramic image in some Web 
Browsers with add-ons, or with some VR Headsets using the correct application that can 
view a panoramic image. 

 

Figure 20 - Screenshot of a wysiwyg scene exported as a 360 degree Panoramic image. 
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Figure 21 - Screenshot of the same Panorama image displayed in the PanoramaViewer app in the 
Google Chrome web browser. 

 

Fixture Highlight (in DESIGN mode only) 
 

   The Highlight feature is in Design mode only, available in the Fixture Selection 
toolbar and in the DESIGN menu. When enabled, Highlight sets the currently selected 
fixture(s) to an open beam at 100% full intensity temporarily, without changes to the 
fixture’s saved settings. 

Highlight is useful when identifying a single fixture or a small selection of fixtures within a 
large and complex plot. 

   

Figure 22 - Screenshot of the Fixture Selection Toolbar, including the new Highlight button  
(at the far right end). 
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AutoCAD Importing Improvements 

For Release 39, we have dedicated a lot of investigation time and effort to making 
improvements to importing DWG/DXF files. Some of the enhancements are more significant 
than others, but overall, the sum of all AutoCAD improvements should resolve many issues 
experienced when importing DWG/DXF files.   

 Memory Consumption 
As discussed, we have investigated numerous DWG files, and have identified a few areas 
of the file import process that could be optimized. As a result, memory requirements 
during the importing of DWG files is much lower than before, and this should result in 
better-performing files (and less crashes due to insufficient memory).  
 

 Text and MText within a block are now imported as separate Text Labels in wysiwyg 
Previously, Text and MText within a block were ignored. 
 

 Attribute text is replaced correctly  
Previously, Attributes needed to be stripped out of the DWG file before importing it, 
because only their variables, not their values, were being imported. This is no longer 
necessary, since Attributes’ values are new converted to wysiwyg Text Labels; in other 
words, the same text as appears when the DWG file is opened in AutoCAD, now appears 
once the import is complete.  
 

 Special logic relating to Layer 0 in nested blocks imported as Library Items is now 
respected in wysiwyg 
This relates to ignoring some objects within a block whose visibility in AutoCAD is 
controlled by Frozen or Off layers. For some blocks, this greatly improves accuracy of 
what geometry is visible in AutoCAD vs. what is included in the Library Item in wysiwyg.  
 

 A new column has been added to the Layer step in the wizard, showing the state of 
the layer in the DXF/DWG file  
Frozen layers are deselected for import by default. Off layers are selected but when 
imported will be set to Not Visible in wysiwyg. Note: wysiwyg Library Items and Layers 
work in a different way from AutoCAD blocks and layers. In some cases, objects are not 
immediately visible in wysiwyg after import and it may be necessary to turn some layers 
on. This is because imported layers that are Off in the DXF/DWG file are not Visible in 
wysiwyg after import.  
 

 A new “Advanced Import Options” dialog appears during Importing and Merging for 
Block Conversions  
This dialog allows you to define the manner in which DXF/DWG blocks are converted 
into Library Items (based on later choosing “Add to Library” in the “Block” step of the 
wizard).  
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Figure 23 - Screenshot of the new Advanced Import Options dialog which appears when importing 
and merging DWG/DXF files with blocks. 

• Number of Segments: This does not only affect Library Items, but also Set Pieces 
created as a result of importing some 3D objects that can’t be converted directly to 
3D Solids (Cone, Sphere, or Cylinder) in wysiwyg. For example, a frustum cone (a 
cone with its peak cut off) is converted to a Set Piece. Previously, the number of 
segments was 40, which resulted in overly complex meshes and much higher memory 
consumption. 8 works very well for truss blocks but 20 may be more suitable for 
some 3D objects.  

• Ignore Layers: Previously, all objects within a block were integrated into the Library 
Item in wysiwyg, which could increase the complexity and also cause the Library 
Item to have a lot of geometry that would be hidden in AutoCAD. Objects on Frozen 
layers are never visible and they can now be skipped. With some justifiable 
exceptions, objects on layers that are not currently visible (but are also not frozen) 
can also be excluded and not integrated into the Library Item. This way, the 
geometry of the Library Item will closely match what is seen in AutoCAD while also 
reducing Library Item complexity (resulting in improved performance, and less risk 
of memory-related crashes).  

 Improved accuracy for position and orientation of some cylinders, cones, spheres, 
and risers. 

 
 All Paperspace blocks should now be ignored by wysiwyg under all circumstances. As 

such, you no longer need to remove Paperspace layouts from the DWG file before 
importing it. 
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 Planar surfaces, helixes, and revolved surfaces are now imported rather than being 
ignored. 

 

 The Import Summary contains a few extra details about the complexity of Library 
Item meshes: Additionally, an ImportSummary.log file is created in 
"Documents\WYSIWYG Files" that keeps track of the summary details. These can be used 
to compare imports of the same file with different settings. 

 

 

 

 

 

Data Mode Features  

Mode Column is now Available in Spreadsheets 
 

A new column has been added in the DATA > Spreadsheet tab, which lists a Fixture's Mode 
setting. Previously, this information was only available in the Fixture Options column, 
amongst other fixture options. 

 

Figure 24 - Screenshot of the Spreadsheet view, with new Mode column shown (4th column in this 
image). 
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Presentation (PRES) Features  

Batch Printing Improvements 
 

A few improvements have been made to the Batch Printing feature for Reports and 
Worksheets in PRES mode. 

 Improved Performance with Batch Printing in Worksheets. 
 
 Individual Tab sheets are now displayed again when performing a Batch Print in 

Reports. 
 

 Batch Printing a Report with multiple Tab sheets was changing the Font Size of the 
non-active sheets. 

 
 

Legend Improvements 
 

A couple of improvements have been made to the Legend Wizard in the Layouts tab. 

 Two new columns, Mode and # Channels, have been added to the Legend. 
 

 Legend Column names can now be renamed from the Display Column Options. 
 

 

Figure 25 - Updated Legend Options dialog which supports renaming Column headers. 
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General Features 

Scene Database Improvements 
 

In the Scene Database, it is now possible to select multiple Scenes listed in the Scene 
Database. This will make things a lot easier when multiple Scenes must be deleted in 
your file. 

 

 

Figure 26 - Updated Scene Database displaying multiple Scenes can be selected at the same time. 

 

CyberMotion Added to Device Manager 
 
An interface to connect to XLNT’s Cybermotion motion console is now included in 
wysiwyg’s Device Manager. The XLNT team has developed a driver to connect to 
wysiwyg to visualize motion controlled by the Cybermotion console.  
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Library - New Fixtures Additions and Corrections  

 

New Library items in wysiwyg R39 

Many new library items are available in R39 (220 fixtures, 2 accessories, 1 console device, 
134 gobos, 112 truss items, 51 library objects). 

New Automated Fixtures 
Manufacturer Model 

Terbly G9B 

Cameo Movobeam 100 

 Auro Bar 100 

URC Solaris 

PR Lighting XR 440 BWS 

SGM G-Wash 

 G-4 Wash 

G-4 WashBeam 

P-1 

GLP JDCI 

Ayrton MagicBlade Fx 
 Merak 
 Arcaline 3-N 
 WildSun S25 
VariLite VL6000 Beam 
Philips SL LED Spot 300 
PRG Icon Edge 
 Bad Boy GC (Ground Control) 

Best Boy GC 
GCLT 

Clay Paky Axcor Profile 900 
 Scenius Unico 
 K-Eye K10 
 K-Eye K20 
Robe Robin Viva CMY 
 Robin LEDWash 600 Plus 
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Manufacturer Model 

 Robin LEDBeam 150 
High End SolaSpot Frame 2000 
 SolaTheatre 
 Hex 
 Quad 
 SolaSpot Pro 1000 
 SolaWash FX 1000 
LEDBlade LED Blade 494mm 
 LED Blade 994mm 
 LED Blade 1994mm 
Elation Chorus Line 8 
 Chorus Line 16 
 Proteus Beam 
 Sniper Pro 
 Platinum 1200 Wash 
 Fuze Wash Z120 
 Fuze Wash Z350 
 Lumina Matrix 
 Six Par 19Z IP 
 E Spot III 
 Paladin 
 Rayzor 360Z 
 Platinum Seven 
 Platinum Spot 35 Pro 
 Platinum Profile 35 Pro 
Chauvet Rogue R3 Wash 
 Intimidator Scan LED 300 
 Intimidator Beam LED 350 
 Intimidator Spot LED 350 
 Intimidator Spot LED 450 
 Intimidator Hybrid 140SR 
 Intimidator Trio 
 Intimidator MK1 Hybrid 
CKC Lighting S70605-CKC 
 S70701-CKC 
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Manufacturer Model 

 S70703-CKC 
 S70705-CKC 
 S70901-CKC 
 S71101-CKC 
 Chromapix 33 
Microh Ultra Trinity 280 
  

  

  

New LED Conventional Fixtures 
Manufacturer Model 

Prolights Eclipse HDTU 19deg 
 Eclipse HDTU 26deg 
 Eclipse HDTU 36deg 
 Eclipse HDTU 40deg 
 Eclipse HDDY 19deg 
 Eclipse HDDY 26deg 
 Eclipse HDDY 36deg 
 Eclipse HDDY 40deg 
 Evo 190EFC 19deg 
 Evo 190EFC 26deg 
 Evo 190EFC 36deg 
 Evo 190EFC 50deg 
DTS Scena 80 LED Fresnel 
 Scena 80 LED PC 

 

New LED Fixtures 
Manufacturer Model 

LDDE SpectraLedPr10 RGBW 
 SpectraLedPr20 RGBW 
CLF Yara 
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Manufacturer Model 

Very-Stage LP0615 
 LWW61415 
GTD GTD-LP354P 
 GTD-L348 
 GTD-L6238P 
 GTD-L372P 
 GTD-L3238P 
Spotlight FresneLED 50 Compact 
 FresneLED 50 Compact ISP 
 FresneLED 100 Compact 
 FresneLED 250 (RGBW) 
 FresneLED 250 TW 
 ProfiLED 50 ZS PS 
 ProfiLED 50 ZS 
 BeeLed 
Showtec Power Spot 9 Q5 
Prolights HaluStrip 
Longman Phenix 300B 

DTS Freeline 30 
 Freeline 60 
 Freeline 90 
 Focus FC 
 Focus Solo FC 
 Focus Solo Zoom FC 
 Brick 
Acme BL-200 WW2 
 Infinity Matrix LED MTX36 
 MP-400Z IP 
GDS Liteware HO 
 Liteware UL 
 Satellite 
Cameo PixBar 600 Pro 
 PixBar 650 Pro 
 Auro Matrix 500 
 Zenit P40 
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Manufacturer Model 

 Zenit P130 
 Thunder Wash 100 RGB 
 Cameo Matrix Panel 3 WW 
Dia Lighting Dia LED Bar 48 RGBW 
JB Systems Accu Color 
LA Technologies Tom Cat 1000 
Intella Systems Intella Storm 1000 RGBW 
 Intella Storm 1000 RGB 
Toppest Top 1080 LED RGB Wash Strobe 
Studio Due CityBeam LED 24 RGBW 
American DJ Saber Spot RGBW 
 Sunray Tri DMX 
 Mega Par Profile 
SGM i-2 RGBWUV 
 i-5 Series 
Acclaim ALQ Par 
Blizzard Lighting LB-Par 
GLP Scenex LED Sphere 50 
Starway ParKolor 120 HD 
 ToneKolor 4406HD 
Litecraft ZX.6 
DTS Delta 10 F RGBA 
Astera Pixel Tube 16 
Philips ArenaVision LED 
Clay Paky K-Eye S10 
 K-Eye S20 
 Odeon Flood RGBW 
 Odeon Graze 600 RGBW 
 Odeon Graze 1500 RGBW 
EV Light CL-P5 
 EV 1019B City Par 
 EV 1072B 
Robe Robin Parfect 150 
 PixelPatt 
 Halo (Accessory) 
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Manufacturer Model 

 Halo (Fixture) 
 Liteware HO2 
 Liteware Satellite 2 
Triton Blue Wally 336 
EK Lights Collider FC 
BriteQ BT-SmartZoom  
Elation DTW Blinder 350 IP 
 DTW Blinder 700 IP 
 DTW Bar 1000 
 ZCL 360 Bar 
LEDBlade LED Blade 494mm 
 LED Blade 994mm 
 LED Blade 1994mm 
CLF Yara 
CKC Lighting Y10301-CKC 
 Y31201-CKC 
 Y31202-CKC 
Microh LED Max Zoom 
 LED Tri Bar 
 LED Razor45 
 LED Max Par Tri 
 LED Chameleon 
LDDE SpectraConnect T5 LED 
 NanoPix 1440 HP 
 NanoPix 2880 HP 
 NanoPix Cyc 
 SpectraLedPr10 RGBW 
 SpectraLedPr20 RGBW 
Chauvet Freedom Stick 
 Fxpar 9 

 

New Conventional Fixtures 
Manufacturer Model 
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Manufacturer Model 

ETC Irideon FPZ 
Thomas/Generic Par36 4-Lite Vertical 1-Cir 
 Par36 4-Lite Vertical 2-Cir 
 Par36 4-Lite Vertical 2-Cir 
 9 Lite Par 64 9-CCT 
 6 Lite Par 36 3-CCT 
 8 Lite Par 36 4-CCT 
 12 Lite Par 36 4-CCT 
 12 Lite Par 36 6-CCT 
Portman P2 Hexaline 
 P2 Hexaline 6cct (6 circuit custom) 
Generic DMX Device 256 
 DMX Device 512 

 

New Effects  
Manufacturer Model 

MagicFX CO2 Jet 

 Power Jet 
 Flamaniac 
 Power Shot 
 Psyco2Jet 
 Shot Base 
 Stadium Shot 
 Stage Shot II 
 Switchpack 
 Stage Flame 
 Stage Propeller 
 SmokeJet 
Explo GX2 Flame 
 X2 Power Flame 
 X2 Wave Flamer 
Smoke Factory Captain D Hazer 
 Tour Hazer 2 
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Manufacturer Model 

Elation Antari UV Wash 2000 

 

New Video Projector  
Manufacturer Model 

Digital Projection Titan Quad WUXGA 

 

New Accessories 
Manufacturer Model 

Donut Generic 

Headset Station 
Symbol Generic 

 

New Truss 
Manufacturer Series Component 

Milos QTV 212 Section (Custom) 

  250 Section 

  356 Section (Custom) 

 QTL QK1LGT Multi Cube 

  QKC1 Multi Cube 

Generic Floor Mount 50cm x 50cm Floor Base 

 Metric Booms 0.25m 

  0.5m 

  0.75m 

  1m 

  1.5m 

  2m 

  2.5m 
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Manufacturer Series Component 

  3m 

  3.5m 

  4m 

  4.5m 

  5m 

  5.5m 

  6m 

Solotech Delirium Tower 78in Left 

  78in Right 

  TP-16 

ASD SR6043 SR6043M 

  SR6043RH 

  SR6043RV 

Tyler SR-GT SR-GT142448B 

  SR-GT142460B 

  SR-GT142496B 

  SR-GT1424120B 

Arcofab TWD-1616S TWD-1616-024S 

  TWD-1616-120S 

  SR-TWD-1616-024S 

  SR-TWD-1616-120S 

Litec MyT TE TR150M-15M-A 

  TE TR150M-30M-A 

  TE TR150-C4 

 RL105A RL105100A 

  RL105200A 

 QL85A LT QL85100A 

  LT QL85300AB 

  LT QL85200A 

  LT QL85100AZ1 

  LT QL85300A 

Eurotruss PRT PRT-L305 
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Manufacturer Series Component 

  PRTD-L305 

 FD44 Circle FD44-25mtr 28seg 

HOF 290-2 0.25m 

  0.5m 

  1.0m 

  1.5m 

  2.0m 

  2.5m 

  3.0m 

  3.5m 

  4.0m 

  4.5m 

  5.0m 

  2-Way Corner C19H 45deg  

  2-Way Corner C20H 60deg  

  2-Way Corner C21H 90deg  

  2-Way Corner C22H 120deg  

  2-Way Corner C23H 135deg  

  2-Way Corner C31H 90deg  

  3-Way C35 T Piece  

  3-Way C36 T Piece  

  4-Way C41H Cross 

  4-Way C42H T Piece 

  2-Way Corner C19V 45deg  

  2-Way Corner C20V 60deg  

  2-Way Corner C21V 90deg  

  2-Way Corner C22V 120deg  

  2-Way Corner C23V 135deg  

  2-Way Corner C31V 90deg  

  2-Way C41V Cross 

  2-Way C42V T Piece 

  4-Way Corner C44V 90deg 
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Manufacturer Series Component 

OV OV40 OV-040 

  OV-060 

  OV-075 

  OV-CB 4W 

  OV-CB 6W 

Tyler GT GT48 

 SR-GT SR-GT142448B 

  SR-GT142460B 

  SR-GT142496B 

  SR-GT1424120B 

ATC SBK29-4X Circle SBK29-4X-04000-3 

  SBK29-4X-06000-4 

  SBK29-4X-08000-5 

  SBK29-4X-12000-8 

Global Truss 
(Europe)  F34 F34040 

  F34080 

  F34VC0-180 Left 

  F34VC0-180 Right 

  F34R20-90 

TAF TQ3-29 Section TQ3-29-0900 

  TQ3-29-0930 

  TQ3-29-0950 

  TQ3-29-1000 

  TQ3-29-2000 

  TQ3-29-3000 

 TQ4-29H Roof Corners TQ4-29H-30 R1-BR C-TQ4 

  TQ4-29H-30 R1-BL C-TQ4 

  TQ4-29H-21 R1-FR L-TQ4 

  TQ4-29H-21 R1-FL L-TQ4 

  TQ4-29H-35 R1-Mid T-TQ4 

 TQ4-29H C-TQ3 Roof Corners TQ4-29H-21 R1-FR L-TQ3 

  TQ4-29H-25 R1-Mid T-TQ3 
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Manufacturer Series Component 

  TQ4-29H-30 R1-BL C-TQ3 

  TQ4-29H-30 R1-BR C-TQ3 

  TQ4-29H-21 R1-FL L-TQ3 

 

New Gobos 
Manufacturer Model 

CKC Lighting 10-Hole Circle 

 12-Point Star 

 3-Bars 

 3-Dot Row 

 4-Hole Large 

 4-Hole.bmp 

 4-Point Star 

 Bar Brackets 

 Bar Horizontal 

 Bar Vertical 

 Bars 

 Bi-Fan Vertical 

 Bio 

 Cone Tunnel Obscura 

 Cone Tunnel 

 Crescent Moons 

 Dots Large 

 Dots Medium 

 Foliage 1 

 Fracture 1 

 Grid 5x7 

 Linear 1 

 Pinwheel 

 Radial Cones 

 Radial Petals 



  

 

 

  Page 42 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

Manufacturer Model 

 Radioactive 

 Squished Triangle 

 Sticks 1 

 Throwing Blade 

 Tri-Force 

 Triangle Tunnel 

 Tribal 

 Wavy Triangle Offset 

 Whirlpool 

PRG Ninja Star 

 Posilines 

 Lines 

 Pivot 

 Mottle Breakup 

 Four Hole 

Terbly Broken Star 2 

 Dot Sine Curve 

 Dots 

 Dots Large 

 Radioactive 3 

 Wavy Tadpoles 

Color Imagination Blue Swirl 

 Celtic Knot 

 Circle of Rings 

 Flower 1 

 Orbits 

 Pinwheel 2 

 Pinwheel 3 

 Radial Ovals Blue 

 Radial Rings Red 

 Radioactive Red 

 Sine Curve Red 
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Manufacturer Model 

 Spiral Tunnel Magenta 

 Star Tunnel 

 Tadpole Flower Magenta 

Varilite 4440 Ballz 

 6008 TriCone 

 4218 Grid 

 4304 Cyclone Spiral 

Chauvet 4-Dot Row 

 10-Dot Circle 

 3 Tadpoles 

 4-Hole 

 4-Square 

 5-Dot Badge 

 Arrow Heads 

 Bio 

 Cone Tunnel 

 Dot Target 1 

 Dots Low-Res 

 Pinwheel 1 

 Plus Cross 

 Radial Circles 

 Radial Petals 

 Random Bars 

 Row of Ovals 

 Sine Curve 

 Triple Scythe 

 IBLED 350 G1 

 IBLED 350 G2 

 IBLED 350 G3 

 IBLED 350 G4 

 IBLED 350 G5 

 IBLED 350 G6-7 



  

 

 

  Page 44 of 62
   

© CAST Group of Companies Inc., 2017. All rights reserved. 

Manufacturer Model 

Gobo Plus Honeycomb 

Cast CastLaser 2 Dots Small 

 CastLaser 3 Dots Small 

 CastLaser 3 Dots Line 

 CastLaser 4 Quarter Circles 

LightHouse31 LE Spot Cobblestone 

 LE Spot Fire 

 LE Spot Gear 

 LE Spot Line Burst 

 LE Spot Linear 

 LE Spot Offset Circles 

 LE Spot Pinwheel 

 LE Spot Radial Trapezoids 

 LE Spot Rose Window 

 LE Spot Spiral 

 LE Spot Splat 

 LE Spot Squares 

 LE Spot Squeezed 

 LE Spot Squiggle 

 LE Spot Sticks 

 LE Spot Sun Flower 

 LE Spot Time Tunnel 

American DJ Radial Ovals 

 Radial Ovals 2 

Prolights Tri-Orbit 

 Fancy Cross 

 Panorama Swirl 

Acme Dot Target 

 Pendant 

 Wavy 

 Wavy Cone 

 Broken Circle 2 
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Manufacturer Model 

 Radial Semi-Circles 

 Radial Fan 

 Arrow Heads 

LightHouse31 LE Spot Cobblestone 

 LE Spot Fire 

 LE Spot Gear 

 LE Spot Line Burst 

 LE Spot Linear 

 LE Spot Offset Circles 

 LE Spot Pinwheel 

 LE Spot Radial Trapezoids 

 LE Spot Rose Window 

 LE Spot Spiral 

 LE Spot Splat 

 LE Spot Squares 

 LE Spot Squeezed 

 LE Spot Squiggle 

 LE Spot Sticks 

 LE Spot Sun Flower 

 LE Spot Time Tunnel 

Elation Random Lines 

 Random Triangles 

 Multi-Rings 5 

CLF Burst 

 Ovals 

 Pinwheel 1 

 Rose 

FineArt Bark Breakup 

 Breakup 1 

 Swirls 
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New Library Items 
Category Item 

Audio Speakers - 
Meyer 500-HP 

 900-LFC 

 Leopard 

 Lyon 

 MJF-208 

 MJF-210 

 MJF-212 

 MM-10ACX 

 MM-4XP 

 UP-4XP 

 UPQ-1P 

 MTG Lyon Top Grid 

 MG Leopard-900 Grid 

 Lina 

Audio Speakers - 
Adamson SpekTrix 

 SpekTrix W 

 SpekTrix Sub 

 S10 

 S10 Standard Frame 

 S10 Extender Beam 

Audio Speakers - 
Seeburg TSM 10 

Musical Instruments Oboe 

 Bassoon 

 Double Bassoon 

 Piccolo 

 Bass Drum on Stand 

 Big Bass Drum 

 Baritone Saxophone 

 Soprano Saxophone 

 Bass Clarinet 
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Category Item 

Quest Events -   
Formset Panels Crosshatch 

 Dimples 

 Fans 

 Flat 

 Pats 

 Petals 

 Pipes 

 Ripples 

 Silos 

 Squares 

Quest Events -  
Geo Panels Bubbles 

 Circle 

 Interlocking 

 Kaos 

 Rolling Blocks 

 Solid 

 Squares 

Quest Events -  
Moddim Panels Bar 

 Bend 

 Crackle 

 Pin 
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Updated Library items in wysiwyg R39  

The following fixtures and accessories have been updated/corrected in wysiwyg R39. 

Manufacturer/Name Correction/Update 

Acme XP-16R BSW DMX Personality update 

Arri HMI Douser Added Design Mode operation option. New Version 

Ayrton Versapix RS Enabled in Design Mode 

Cameo Thunder Wash 600 RGB Added 6-Channel Mode-2 

Chauvet COLORrail Added missing Color Speed channel 

Chauvet Maverick MK2 Spot Strobe operation correction. 

Chauvet Rogue R1 FX-B Pan/Tilt corrections 

Clay Paky Scenius Series 
Corrected Tilt movement in Vector Mode to match 
Standard mode. 

Clay Paky Shar-Bar 
Added LED Swap Option. Pan/Tilt and Cad Symbol 
refinements 

DTS Helios FC 12, Donut FC 18 Added Z1 Type 8-Bit mode 

DTS Katana Reversed LED Order 

Elation ACL 360 Bar and Matrix Improved Beam properties 

Elation Cuepix Blinder WW4 Strobe operation correction. 

ETC Source 4 LED series 1 and 2 Patch update for DMX Fan and Strobe options 

Fargo Stage Par 19 Pro Zoom Added 9-Channel Mode. 

GLP Impression X4 Bar 20 Dual Mode Patch correction 

GTD L3100, L350 Improved Beam properties 

Lumenpulse Added Lenses for LumenFacade series. 

Martin Mac Axiom Version 3. Tilt, Gobo and Colour corrections. 

Martin MAC Viper series Updated Gobo Rotation rates. 

Martin Sceptron series Added 5-Channel 16-Bit control mode. 

Philips SL Bar 510 RGBW Added Simple 8-Bit Mode. 

Philips SL Nitro 510C Added Expanded Mode, Effect Channel adjustments 
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PR XR 300 Beam Gobo Update 

Robe Robin DL7 Profile and Wash 
Framing Shutter re-order and added Zoom Range 
option. 

Robe Robin LEDWash 600 series Zoom range update 

SGM X-5 Wattage correction 

SGM Q-7 Added new DMX modes 

Showtec Sunstrip Active Wattage correction for alternate lamps 

Terbly G9 Hybrid Updates from Manufacturer 

Terbly OK190Z-R Pan/tilt, zoom update 

Terbly V3000P-R Framing Shutter Update 

High End Showgun Wattage correction 

ETC ColorSource Series New DMX personalites 
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Resolved Issues in wysiwyg R39 

1. The Library Browser buttons do not work when the Library Browser is opened from the 
Welcome Screen. 
This issue has been resolved. The Back, Forward, Up, Home and Item Properties buttons are 
now enabled when required. 

2. Fixtures inserted on Floor cannot be patched by drag and drop method on to the Patch 
tab as can be done with Fixtures on Hang Structures.  
This is now fixed. The drag and drop method now works with Fixtures on the Floor. 

3. CAD Items in the Layouts tab is showing Hatch Styles, Focus Objects and Dimensions, 
even when these objects have been disabled in Document Options and therefore should 
not appear.  
This is now fixed. The CAD Items in Layouts are now respecting the options as specified in 
Document Options. 

4. Copying a row in the Spreadsheet view that is in a group and pasting it into another group 
will cause a crash.  
This is now fixed. A copy/paste of these grouped rows in Spreadsheet will not cause a crash 
anymore. 

5. Unchecking the “Show Dimensions” checkbox in Document Options > Wireframe Details 
only hides Linear Dimensions; other Dimensions are still displayed.  
When the “Show Dimensions” Document Option was unchecked, only the Linear Dimension 
object was hidden, leaving Radial, Arc, Angle Dimensions and Linear Scales to be displayed. 
This is now fixed. 

6. Exporting a wysiwyg file as 2D DWG/DXF export should export as Text objects in AutoCAD 
instead of Line segments of a 2D text font.  
This is now fixed. wysiwyg will export Text Objects as AutoCAD Text objects in 2D exports, 
as it does in 3D exports. 

7. A black blob artifact appears on Transparent Surfaces when the Screen Glow option is 
enabled in Shaded Views.  
In some extreme cases on larger files with many transparent Screens and the Screen Glow 
option enabled, this can create some black pixel areas in the Shaded View. This is now fixed. 

8. Sort indicators in the Layer Database headers are invisible.  
This is now fixed. The ˄ or ˅ symbols that represent sort order are now always displayed.  

9. Sometimes a long delay is experienced when cancelling a Batch Print job in PRES mode.  
When a Batch print job was started and cancelled in PRES mode tabs such as Layouts, Reports 
and Worksheets, a long delay would be experienced before the GUI was responsive. This is 
now fixed. 
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10. Batch Printing dialog in Reports does not show individual tab sheets anymore.  
This printing issue is now resolved. Individual Tab Sheets will be listed individually if 
“Combine Group Sheets” option is unchecked when Batch printing Reports. 

11. Batch Printing a Report with multiple sheets changes the Font Size of the non-active 
sheets.  
This case is now handled correctly. Font Sizes are now printed as defined for the non-active 
sheets. 

12. Symbols do not appear in New Plots.  
This is now fixed. Symbols are now appearing once again in New Plots.  

13. The “Type” attribute in Fixture Attribute Layouts cannot be made invisible in Layouts.  
This issue is now fixed. The Type attribute respects the “Show on Plot” properties as defined 
in Document Options > Wireframe Details.   

14. 3D DWG Export does not export text from Dimensions, Focus Objects, or Camera Target 
object correctly, and sometimes the text is not exported at all.   
These issues are now resolved. Exported text is displayed and with the correct font 
properties.  

15. Mirroring a Pipe with Borders and Legs only mirrored the Pipe and not the Borders and 
Legs.  
This is now fixed. Borders and Legs also mirror together with the Pipe. 

16. A Pipe’s Border and Legs do not appear in New Plots until after wysiwyg is restarted.  
This issue is now fixed. The Border and Legs appear as expected in New Plots, once drawn in 
the file. 

17. When drawing an interactive Pipe, using the Command Line to define the length uses the 
position of the cursor instead.  
This issue is now fixed. Now, if the user defines a length for the Pipe in the Command Line, 
this value will be the length of the new Pipe inserted into the drawing.  

18. For French version, the Document Options > Date field shows 0 for the month.    
This issue is now fixed. The Date field now correctly displays the number 1-12 displaying the 
month.  

19. Importing an old .3DS file may result in an invalid material preventing the .WYG file to be 
loaded after it is saved.  
Due to the older .3DS file’s encoding of the text, importing the file with material was not 
handled correctly. This has been fixed. 

20. When a User Origin is defined, mirroring Truss with Fixtures will move the Fixtures to the 
Flight Case.  
The case for User Origin is now handled correctly, and Fixtures will be mirrored and placed 
on the Truss correctly. This issue has been fixed.  
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21. Revision History should be set when a .WYT file is saved as .WYG file. 
This is now fixed. Revision history and File Date are reset now when a .WYG file is saved from 
a .WYT file.  

22. When video stops playing on a Screen, the Screen appears white in DESIGN and LIVE 
Shaded Views. 
This is now fixed. Screens will now appear black instead of white when the video stops 
playing in these Shaded Views.  

23. Toolbar interference issues experienced between Command Line and Fixture Selection 
toolbars.  
This issue is now fixed. Command Line and Fixture Selection can be independently 
enabled/disabled from the Application Options > Toolbars tab, and also from the right-click 
menu in the Toolbar area. 

24. wysiwyg crashes when cloning a Scene if running on a Windows 7 computer. 
This is now fixed. Scenes can be cloned if wysiwyg is running on a Windows 7 computer.  
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Known Issues 

1. Users running wysiwyg on computers with integrated video cards have reported quality and 
performance related issues in the wysiwyg Shaded View 
This problem is related to very limited hardware support for features required by wysiwyg’s 
Shaded View. Please ensure that you have the latest graphics drivers for your computer. If issues 
are still experienced in Shaded View, please turn off any unnecessary visualization features, as 
per the advice offered in the following article: http://www.cast-
soft.com/wysiwyg/tip/view/improving-performance-in-r32s-shaded-view. 
Please note that although wysiwyg will run on a computer with an integrated graphics card, this 
is not recommended for larger files, and especially not for pre-visualization or pre-cueing--please 
use a computer with a dedicated/discreet video card instead. For more information about 
updating your video card drivers, we recommend that you refer to the following thread on our 
Forum: http://forums.cast-soft.com/index.php?threads/general-information-on-fixing-shaded-
view-problems-crashes.302. 
For more information about wysiwyg's hardware requirements, please visit: http://www.cast-
soft.com/content/wysiwyg-system-requirements 

2. The glow feature for LED Wall and Screens will always display a white glow when running on 
systems using integrated graphics. 

Integrated graphics cards do not support Enhanced Visualization or Deferred Shading. As a result, 
although the glow is visible, the color of the glow remains white. 

3. While changing the video resolution of a CITP source while playing, it can take up to 10 
seconds before the video is displayed without artifacts at the new resolution.  

During this time, some artifacts are visible in the video displayed. It is advised that you set the 
video resolution at the beginning of your design work, and not change during your presentations. 

4. You cannot perform a second Merge operation on a merged item that has been mirrored 

After mirroring an object that was originally created through a merge operation, you cannot 
reliably perform another merge procedure on this object. 

Workaround: It is recommended that you perform all Merge operations on these objects before 
you mirror them. 

5. Single-sided surfaces that have Light Emission enabled "glow" on both sides when rendered 

When you assign light emission to a single-sided surface, and then render it with Radiosity turned 
on, the surface appears to glow on both sides.  

Workaround:  When using a light-emitting surface, create a second surface (with no light 
emission) of the same size and place it just behind the light-emitting surface, 1 or 2 millimeters 
away. This will mask the second light-emitting side in your rendering. 

http://www.cast-soft.com/wysiwyg/tip/view/improving-performance-in-r32s-shaded-view
http://www.cast-soft.com/wysiwyg/tip/view/improving-performance-in-r32s-shaded-view
http://forums.cast-soft.com/index.php?threads/general-information-on-fixing-shaded-view-problems-crashes.302
http://forums.cast-soft.com/index.php?threads/general-information-on-fixing-shaded-view-problems-crashes.302
http://www.cast-soft.com/content/wysiwyg-system-requirements
http://www.cast-soft.com/content/wysiwyg-system-requirements
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6. For fixtures with multiple circuit types you cannot manually select which type to display in 
DATA mode 

Regardless of the number of circuit types associated with a particular fixture and the Regional 
Settings that you choose for your file, there is no way to select which circuit type to show in 
DATA mode; instead, the program will always show the first circuit type listed.  

7. After saving your wysiwyg file directly to a Network Attached Storage (NAS) device or any 
other remote drive/location, including (potentially) USB drives, you may have trouble 
opening the file 
Workaround:  Work on files that are kept on your local hard drive. Before you begin working on 
the wysiwyg file, copy it to your local drive and open it from there; once you are finished 
working on it, save the file (on your local hard drive) and then move it back to your NAS device.   

8. When you uninstall and reinstall the wysiwyg Server, the network version of wysiwyg 
(Network or Learn) does not function properly 

When you install wysiwyg Release 35 the program installs updated Sentinel Drivers that make it 
unnecessary to subsequently install the wysiwyg Server (for the network versions of wysiwyg). 
However, if you install wysiwyg Release 35 and the wysiwyg Server, and then subsequently 
uninstall and reinstall the wysiwyg Server, the program will not function properly.  

In this case, perform the following workaround: 

1) Click Start > Control Panel > Add or Remove Programs. 
2) From the list of programs, click Remove beside the following programs, and then follow 

the steps to remove them from your computer: 
• all listed versions of the Sentinel Drivers 
• the wysiwyg Server 

3) Restart your computer. 
4) When these programs are removed, reinstall the Sentinel Drivers by double-clicking the 

file Sentinel.exe located in the following folder: 
C:\Program Files (x86)\WYSIWYG Release 35\Bin\Sentinel 

Note: C: is the drive on which you installed wysiwyg. 

9. Transparent surfaces that touch non-transparent objects are not transparent in the rendered 
image  

To ensure that transparent surfaces touching non-transparent objects are completely invisible in 
renderings requires a slight workaround. When placing the transparent surface or object in your 
drawing, ensure that a minuscule space exists between it and any non-transparent objects in 
your drawing (this space can be as small as you like). For example, if you are placing a 
transparent surface on a floor, nudge the surface just above the floor. When you render the 
image, the surface will be invisible. 

10. wysiwyg does not detect the appropriate size of color frame for some fixtures that have 
interchangeable lenses 

wysiwyg is not distinguishing the lens from the body of certain fixtures that have 
interchangeable lenses, such as the Strand SL. In some cases, therefore, it allows you to use the 
incorrect size of color frame for the current lens. For example, a Strand SL fixture with a 26° lens 
uses a 6.25-inch color frame, but wysiwyg also allows you to use both a 12-inch and a 14-inch 
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frame (the frames used by 10° and 5° lenses respectively).  
Note: This issue was previously experienced with the Source 4 fixture, but it has since been fixed 
in R38. 

To avoid this issue, ensure that you know the appropriate color frame for each lens that you are 
using. Select a color frame from the accessories tab of the library browser and insert it into the 
fixture(s). Then open the properties of the color frame and select a color to apply to the 
accessory. 

11. Deleted Presentation items are still available in Layouts 

Removing a new plot, image, report, worksheet, key, legend, or spreadsheet from its respective 
shortcut bar using Undo does not remove it from the list of items available for insertion in 
Layouts. Such items are named “new view” in their respective list and can be added to the 
layout but may cause wysiwyg to crash. 

12. Positional link not broken for grouped objects in a New Plots view 

Performing a Move or Rotate command on a set of grouped objects in a New Plots view does not 
properly break the positional link. If you try to restore the positional link for these objects, they 
will return to the position they were in immediately before the positional link was broken, not to 
their current position in CAD mode. They will move to the correct position if the objects in CAD 
mode are ungrouped and regrouped. 

13. Positional link not broken for grouped hang structures in a New Plots view 

Performing a Move, Rotate, or Rotate Position command on a set of grouped hang structures 
(such as truss) in a New Plots view does not properly break the positional link. If you Move or 
Rotate the hang structures in CAD mode, the hang structures in the New Plots view will change 
their position as well. They will not be moved if you ungroup the hang structures before moving 
or rotating them, and then regroup them when the operation is finished. 

14. 'Windows' created with the Boolean > Subtract tool disappear when the file is re-opened.  

If 'windows' are cut out from a 'wall' surface when both the wall surface and the surfaces that will 
be used for the cutouts were created by extruding lines, after saving and closing the file, re-
opening it causes the windows to be filled in again in Shaded View. In Wireframe views, the 
cutouts are still there. 

15. Bring to Front and Send to Back commands in CAD Wireframe and in Layouts cannot be 
undone. 

The Undo command will undo the action previous to any Bring to Front/Send to Back commands. 
Reversing the operation must be done manually and it may take several steps to return objects to 
their original draw order. 

16. Performing 15-20 Boolean operations in a File may lead to a crash on the next Boolean 
operation. 
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There is a limit due to geometric complexity, but it varies depending on the file and objects and 
is unpredictable. If performing repeated Boolean operations on the same objects, it is 
recommended that you save and back up your work often – perhaps even after every successfully 
complete operation. 

17. When undoing and redoing move commands involving objects attached to an axis or frame or 
a grouped axis or frame, the objects may end up positioned incorrectly. 

18. In Layouts and New Plots, the measurement unit type shown in the Status Bar does not 
always match the unit type used in the Layout or New Plot. 

19. Changing wysiwyg's (Wyg.exe's) task priority from Task Manager does not always result in 
that priority being retained. 

20. Undo/Redo is not supported for Camera Path nodes set to User Defined. 

21. Fixtures that have multiple beam properties (e.g. Showgun) cannot display the color wheel 
preview information on the Color Designer Tool. 

22. Custom Library Items that are no longer part of the application library and deleted from the 
wysiwyg file cannot be deleted from a file's private library 

A wysiwyg file which contains some custom library items that are not listed in the Application's 
Library Browser (accessed from the Welcome Screen), and that are deleted from the file cannot 
be deleted from the file's library, because the Delete option is disabled when you right-click on 
the custom library object inside the file's Library Browser.  

Workaround:  Performing a Purge Operation on the file will detect the unused custom library 
items in the file and can delete them if the user wishes. 

23. The previous "Un-Hung Fixture" Spreadsheet does not work with the new Spreadsheet 
because the filtering system is different in the new Spreadsheet. 

Workaround:  In the Spreadsheet's filter bar, the Un-Hung Spreadsheet has its Status filter 
dropdown set to "All", and the user can change it to "UNHUNG". 

24. The Symbol Alignment option in Show Options inverts Fixture Lens Number in the Fixture's 
symbol when displayed in Wireframe views. 

25. Linear Scale objects do not export in 3D DWG/DXF exported files. 

Although Linear Scale objects will export to a 2D DWG/DXF exported file, they currently do not 
export to a 3D DWG/DXF exported file. 

26. wysiwyg cannot print to a PDF file if the file's name or path contains Unicode characters that 
do not exist in the current system language code page. For example, if your system is using 
English (United States), you cannot specify a path with Chinese characters. 

Workaround:  One workaround is to name the file using only characters in your system language 
from wysiwyg, and then rename the file afterwards from Windows. Alternatively, if you set the 
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Windows OS language settings to a language which uses the same characters used in the file 
name or path, then the image can be exported successfully. 

27. wysiwyg cannot export the Shaded View to a JPEG image if the file's name or path contains 
Unicode characters that do not exist in the current system language code page. 

Workaround:  One workaround is to save the JPEG in a different image format, (e.g. BMP, PNG, 
etc.), and it will save successfully. Alternatively, save the JPEG image file with a name and path 
only containing viable Unicode characters from wysiwyg, and then rename the file afterwards 
from Windows. 

28. When running wysiwyg in the VMware Fusion virtual machine environment, textures are not 
applied or displayed correctly on surfaces. 

29. When running wysiwyg in the VMware Fusion virtual machine environment, "Save to Image 
view" and "Export to image" options on right click menu may crash wysiwyg. 

Workaround: You can use the PrintScreen feature to capture a screenshot and then paste the 
image into an Image Editing application. 

30. When running wysiwyg in the Parallels or VMware Fusion virtual machine environment, 
enabling the "Soft Shadow" option in the Shaded Views may crash wysiwyg. 

31. When exporting the Shaded View using "Export to Image", video card settings are not ignored 
in the exported image.  

Workaround: This does not happen if the Shaded View is saved to the Images tab first, and then 
exported from the Images tab. Another option is to use the PrintScreen feature to capture a 
screenshot and then paste the image into an Image Editing application. 

32. For imported hatch patterns with dots, printing may not provide the expected results. 

When printing a hatched object that uses a hatch pattern with dots, the dots may appear very 
small and faint or may not appear at all. wysiwyg has several hatch patterns with simulated dots 
that use short line segments instead. This is only a problem if a pattern file is imported.  

33.  

34. Cell Padding is handled differently in Text label objects in Release 36. Therefore, wysiwyg 
files saved in R35 and earlier version containing Text Labels which have cell padding will 
have a different height in Release 36 and later. 

Unlike before where cell padding would reduce the text height, now the cell padding value is 
additional space added around the text. Therefore it will increase the overall height of the text 
label object, which will make the height of a Text Label saved in files from previous releases 
different.  

35. Some PDF Files (particularly Multi-Layer PDF files) may fail to import as floorplans. 
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A few workarounds to this problem are available: 

- 1. Ask for another version of the PDF file (or re-create it), without Layers.  
- 2. Use Adobe Acrobat Pro to flatten/merge the layers. (As stated on the Adobe Help page 

above, this requires the Pro version of Acrobat, which is not free.)  
- 3. If GhostScript is installed on the system, wysiwyg can attempt to use it. Installing the 

latest version of 32-bit GhostScript may help resolve this issue. 
 

36. Object order is not respected in New Plots as it is in CAD Wireframe Views. 

The Send to Back / Bring to Front functions to offer the user a way to define object draw order, 
are not respected in New Plots. As a result, the plot will be displayed differently between the 
CAD Wireframe representation and New Plots representation.  

37. Occasionally when opening a dialog, the window’s border is displayed but the contents of the 
window are not shown. 

This issue happens randomly. If you experience this problem, you can use the ESC key to close 
the dialog or click in the top right corner of the dialog where the X button would be. Usually if 
you try to reopen the same dialog again, all the contents will be displayed the next time it is 
opened.  

38. When switching between tabs or between Visual Themes, wysiwyg mouse clicks may affect 
the window behind wysiwyg. 

During these slower operations, wysiwyg may become temporarily inactive. Avoid clicking the 
mouse until the switch is complete and wysiwyg will stay in the foreground.  

39. Due to differences in how applications work with text, some issues exist with exporting text 
labels to DWG. 

Exporting text labels with multi-line text will result in a text object with one line of text in the 
DWG/DXF file. Text label borders and background fill are not exported. The Align to View 
property is ignored. Text will appear slightly larger and may be in a slightly different position 
from how it appears in wysiwyg, but it is much more accurate than in previous releases.  

40. Depending on DPI settings, Layouts may not display or print certain objects at the specified 
scale. 

Worksheet, Report, Key and Legend objects may be smaller in the Layout due to system DPI 
settings above 100%.  

41. Sometimes when you render a file which has objects imported from SketchUp, the textures 
do not appear in the rendering. 

This is a random bug which happens from time to time. It is possible to determine if the textures 
will be rendered from the small preview before you start the render job. If you do not see any 
textures appearing in the small preview, close the Render Wizard window, and reposition your 
camera and start the Render Wizard again. In most cases, the next time the textures will appear 
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in the rendering (just verify first in the last step of the Render Wizard before starting the render 
job).  

42. Shaded Views are experiencing a performance drop to ~1 FPS on Windows 10 systems which 
have an Nvidia graphics card whose driver is greater than Version 353.62 when going into or 
out of Full Screen mode.    

Some customers are experiencing severe performance drops on their systems, usually down to 
approximately 1-2 FPS. The commonality between all of these reports is: it’s on a Windows 10 
computer, which has an Nvidia graphics card, and the graphics driver is later than Version 
353.62. The issue seems to be triggered when the Shaded View is about to open into Full Screen 
mode, or when it is closing Full Screen mode. CAST is currently investigating this issue, and we 
can report that: 

• This issue is NOT experienced on older graphics drivers that are Version 353.62 and 
earlier. 

• This issue is NOT experienced on systems running an AMD graphics card   

43. wysiwyg DPI drops after connecting to the Hog4 driver if the computer’s DPI setting is above 
100%. 

When wysiwyg is running on a computer which has DPI settings which are greater than 100%, 
connecting to the Hog driver will immediately drop the DPI settings to 100%. This issue is not 
experienced on the same systems with other console drivers. 

44. Accessories’ Attribute Layouts cannot be changed in CAD Mode. 

It is not possible to modify the Attributes Layout for Electronic Accessories via the Edit Fixture 
Attribute Layout window in CAD mode. Please modify these via New Plots instead, by clicking-
and-dragging (or deleting) them as needed. 

45. Measuring Truss with Linear Dimensions may show incorrect measurements for a Truss’ 
length, width, or height. 

The wysiwyg Truss library is represented by lines along the center of the main truss chords and 
does not account for the thickness in the library symbol. As a result, sometimes measurements of 
the truss’ length, width or height with Linear Dimensions snapping to end points may result in 
incorrect measurements as the library models do not account for the Truss thickness. To correct 
this, an optional Truss Thickness was introduced to improve Truss representations, and a new 
Truss Snap feature which includes the truss thickness value when measuring truss can be used. 
This has improved measurement results for many truss objects, but some truss objects may still 
experience discrepancies. Also, many Imperial length truss models will continue to display a 
measurement discrepancy due to converting from metric to imperial, as all truss models in the  
library are drawn as a metric drawing.  

Workaround: Use the Truss Manager and specify the correct measurements in the Auto Dim 
X/Y/Z columns for the Truss objects used in your files and then use the Auto Truss Dimension tool 
and choose the option to use Truss Manager values to measure truss objects.  
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46. Sometimes when the truss thickness option is enabled, some Truss and Pipe may not be 
represented perfectly, especially when the Truss/Pipe object may be rotated. 

Again this is also related to the wysiwyg Truss library being represented by lines and not 
accounting for the thickness in the library symbol. The truss thickness option adds thickness to 
the truss representation which works best when truss is aligned to the main axes, but if truss is 
rotated, sometimes it will not look correct.  

When represented with truss thickness, the Truss symbols display best when aligned to the main 
axes. If they are rotated, the truss representation of the main chords and cross-members may not 
look correct in all cases. This depends on the truss’ angle of rotation.  Similarly, linear and 
curved pipes may also experience similar issues when not aligned to the main axes. 

Workaround: A potential workaround that sometimes helps with displaying truss best is to enable 
truss fill for the truss symbol. For the pipes, sometimes increasing the pipe thickness will help 
display the pipe correctly. 

47. I-Mag Camera is not displayed in Renderings. 

The visuals from the I-Mag camera do not appear in Renderings. 

Workaround: A workaround for this issue is to export the Shaded View of the I-Mag Camera, and 
apply this image as an Image Source to the Screen before starting the Rendering.  

48. SketchUp 2017 files do not import. 

A SketchUp file saved as Version 2017 will not import into wysiwyg. 

Workaround: A workaround for this issue is to save the file back to Version 2016, which will 
import into wysiwyg. 

49. NVidia cards not able to correctly simulate strobing at higher frequencies. 

Strobing fixtures at high frequencies on NVidia cards are not displayed correctly. Conversely this 
same issue is not experienced on a high end AMD graphics card with the same file running same 
strobing cue. As a result, the issue is with the NVidia driver being unable to display the simulated 
beams at such high frequencies.  
 
Strobing at high frequencies is not simulated correctly when using an NVidia video cards: the 
displayed rate is random as opposed to constant. Since the same is not experienced with the 
same file and DMX input running on the same computer but with an AMD video card, the only 
logical conclusion is that this is specific to nVidia video cards. nVidia has been notified about 
this, and it is our hope that they will be able to address the problem in a (near-)future driver 
update (but, naturally, we have no control over when they decide to make this fix a priority). 

50. Some video cards do not support the Alpha Beam shadows feature and may experience a 
crash when switching to Shaded View. 
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To support the graphical requirements of the Alpha Beam Shadows feature, your video card must 
support OpenGL version 4.3. If not, while running simulation in the Shaded View, wysiwyg will 
crash. As a result, and to avoid this, when some AMD video cards that do not support this feature 
are detected, the Alpha Beam Shadows feature will be automatically disabled. However, if a 
crash is still experienced, please see proposed steps to avoid the crash in the Workaround 
below.   

Workaround: In cases where you are attempting to open a file and wysiwyg crashes, from the 
Welcome Screen, open the Application Options and disable “Deferred Rendering” from the 
Simulation tab.  
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Contacting Technical Support 

Please read the online documentation and visit the www.cast-soft.com Web site before contacting 
Technical Support. You can contact Technical Support at the following location. 
CAST Software Technical Support 
35 Ripley Avenue, Unit 1 
Toronto, ON Canada M6S 3P2 
 
Phone: +1.877.989.2298 
Fax:  +1.416.597.9594 
E-mail:  techsupport@cast-soft.com  
Web site: www.cast-soft.com 
 

 

Copyright Information 

© The CAST Group of Companies Inc. 2004-2017. All rights reserved. 
35 Ripley Avenue, Suite 1 
Toronto, Ontario 
Canada M6S 3P2 
 
“wysiwyg”, “Vivien” and “CAST Software” are registered trademarks of CAST Group of Companies 
Incorporated. Other brands or products are the trademarks or registered trademarks of their 
respective holders and should be treated as such. 
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